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OneNote

Productivity Apps for Sway

Office Mix

School and Work G

Corinne Hoisington

Lochlan keeps track of
his class notes, football
plays, and internship
meetings with OneNote.

Zoe is using the annotation
features of Microsoft Edge
to take and save web notes
for her research paper.

Nori is creating a Sway

site to highlight this year’s

activities for the Student

Government Association. Hunter is adding interactive
videos and screen recordings
to his PowerPoint resume.

© Rawpixel/Shutterstock.com

Being computer literate no longer means mastery of only Word, Excel,
PowerPoint, Outlook, and Access. To become technology power users, Hunter,
Nori, Zoe, and Lochlan are exploring Microsoft OneNote, Sway, Mix, and Edge in
Office 2016 and Windows 10.

Introduction to OneNote 2016

Introduction to Sway Learn to use productivity apps!

. : . Links to companion Sways, featuring
Introduction to Office Mix videos with hands-on instructions, are

Introduction to Microsoft Edge located on www.cengagebrain.com.

Productivity Apps for School and Work
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Bottom Line

¢ OneNote is a note-taking
app for your academic and
professional life.

¢ Use OneNote to get organized
by gathering your ideas,
sketches, webpages, photos,
videos, and notes in one place.

& J

Introduction to OneNote 2016

notebook | section tab | To Do tag | screen clipping | note | template | Microsoft OneNote
Mobile app | sync | drawing canvas | inked handwriting | Ink to Text

As you glance around any classroom, you invariably see paper notebooks and notepads
on each desk. Because deciphering and sharing handwritten notes can be a challenge,
Microsoft OneNote 2016 replaces physical notebooks, binders, and paper notes with a
searchable, digital notebook. OneNote captures your ideas and schoolwork on any device
so you can stay organized, share notes, and work with others on projects. Whether you
are a student taking class notes as shown in Figure 1 or an employee taking notes in
company meetings, OneNote is the one place to keep notes for all of your projects.

Figure 1: OneNote 2016 notebook

Each notebook is divided into
sections, also called section
tabs, by subject or topic.

[T Class Notes =

1 Rl

Use To Do tags, icons that
help you keep track of your
assignments and other tasks.

Type on a page
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small window
that contains
text or other
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Learn to use OneNote!
Links to companion Sways,
featuring videos with hands-on
instructions, are located on
www.cengagebrain.com.

Creating a OneNote Notebook
OneNote is divided into sections similar to those in a spiral-bound notebook. Each
OneNote notebook contains sections, pages, and other notebooks. You can use One-
Note for school, business, and personal projects. Store information for each type of
project in different notebooks to keep your tasks separate, or use any other organiza-
tion that suits you. OneNote is flexible enough to adapt to the way you want to work.
When you create a notebook, it contains a blank page with a plain white background
by default, though you can use templates, or stationery, to apply designs in categories
such as Academic, Business, Decorative, and Planners. Start typing or use the buttons
on the Insert tab to insert notes, which are small resizable windows that can contain
text, equations, tables, on-screen writing, images, audio and video recordings, to-do
lists, file attachments, and file printouts. Add as many notes as you need to each page.

Syncing a Notebook to the Cloud
OneNote saves your notes every time you make a change in a notebook. To make sure
you can access your notebooks with a laptop, tablet, or smartphone wherever you
are, OneNote uses cloud-based storage, such as OneDrive or SharePoint. Microsoft
OneNote Mobile app, a lightweight version of OneNote 2016 shown in Figure 2, is
available for free in the Windows Store, Google Play for Android devices, and the
AppStore for i0S devices.

If you have a Microsoft account, OneNote saves your notes on OneDrive auto-
matically for all your mobile devices and computers, which is called syncing. For
example, you can use OneNote to take notes on your laptop during class, and then

Productivity Apps for School and Work
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open OneNote on your phone to study later. To use a notebook stored on your com-
puter with your OneNote Mobile app, move the notebook to OneDrive. You can

quickly share notebook content with other people using OneDrive.

Figure 2: Microsoft OneNote Mobile app

Onehlote

New Browser - Microsoft Edge
Thursday, October 12, 2017 4:-45PM
Notes synced to
OneDrive and Today's Topics:
displayed on a Announcements:
smartphone ® Cortana .
e Annotations * SESEmMoRday
® Web Note
e Hub

Taking Notes

Use OneNote pages to organize your notes by class and topic or lecture. Beyond sim-

ple typed notes, OneNote stores drawings, converts handwriting to searchable text and

mathematical sketches to equations, and records audio and video.

OneNote includes drawing tools that let you sketch freehand drawings such as bio-
logical cell diagrams and financial supply-and-demand charts. As shown in Figure 3, the
Draw tab on the ribbon provides these drawing tools along with shapes so you can insert
diagrams and other illustrations to represent your ideas. When you draw on a page, One-
Note creates a drawing canvas, which is a container for shapes and lines.

Figure 3: Tools on the Draw tab

Draw tab

A
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On the Job Now

OneNote is ideal for taking notes
during meetings, whether you are
recording minutes, documenting
a discussion, sketching product
diagrams, or listing follow-up
items. Use a meeting template

to add pages with content
appropriate for meetings.

Lines and shapes are
in the Shapes group.

Make drawings
= using pens in
the Tools group.

Insert text
using the Type
button in the
Tools group.

Files syncing over the Internet

—rOneNole Pages in the Notebook

Microsoft OneDrive

Converting Handwriting to Text

When you use a pen tool to write on a notebook page, the text you enter is called

inked handwriting. OneNote can convert inked handwriting to
you use the Ink to Text button in the Convert group on the Draw

typed text when
tab, as shown in

Figure 4. After OneNote converts the handwriting to text, you can use the Search box
to find terms in the converted text or any other note in your notebooks.

Productivity Apps for School and Work
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Figure 4: Converting handwriting to text
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Use OneNote as a place to brain-
storm ongoing work projects. If
a notebook contains sensitive
material, you can password-pro-
tect some or all of the notebook
so that only certain people can
open it.

Record Video
button

Recording a Lecture
If your computer or mobile device has a microphone or camera, OneNote can record the
audio or video from a lecture or business meeting as shown in Figure 5. When you record
a lecture (with your instructor’s permission), you can follow along, take regular notes at
your own pace, and review the video recording later. You can control the start, pause, and
stop motions of the recording when you play back the recording of your notes.

Figure 5: Video inserted in a notebook
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1: Taking Notes for a Week
As a student, you can get organized by using OneNote to take detailed notes in your
classes. Perform the following tasks:

a.

b.
C.

d.

Learn to use OneNote!
Links to companion Sways,
featuring videos with hands-on
instructions, are located on

Create a new OneNote notebook on your Microsoft OneDrive account (the www.cengagebrain.com.

default location for new notebooks). Name the notebook with your first name

followed by “Notes,” as in Caleb Notes.

Create four section tabs, each with a different class name.

Take detailed notes in those classes for one week. Be sure to include notes, drawings, and other types of content.
Sync your notes with your OneDrive. Submit your assignment in the format specified by your instructor.

2: Using OneNote to Organize a Research Paper
You have a research paper due on the topic of three habits of successful students. Use OneNote to organize your research.
Perform the following tasks:

a.

b.

(G

d.

Create a new OneNote notebook on your Microsoft OneDrive account. Name the notebook Success Research.
Create three section tabs with the following names:

o Take Detailed Notes
o Be Respectful in Class
o Come to Class Prepared

On the web, research the topics and find three sources for each section. Copy a sentence from each source and paste
the sentence into the appropriate section. When you paste the sentence, OneNote inserts it in a note with a link to the
source.

Sync your notes with your OneDrive. Submit your assignment in the format specified by your instructor.

3: Planning Your Career
Note: This activity requires a webcam or built-in video camera on any type of device.

Consider an occupation that interests you. Using OneNote, examine the responsibilities, education requirements, potential
salary, and employment outlook of a specific career. Perform the following tasks:

a.

b.

Create a new OneNote notebook on your Microsoft OneDrive account. Name the notebook with your first name
followed by a career title, such as Kara - App Developer.

Create four section tabs with the names Responsibilities, Education Requirements, Median Salary, and Employment
Outlook.

Research the responsibilities of your career path. Using OneNote, record a short video (approximately 30 seconds) of
yourself explaining the responsibilities of your career path. Place the video in the Responsibilities section.

On the web, research the educational requirements for your career path and find two appropriate sources. Copy a para-
graph from each source and paste them into the appropriate section. When you paste a paragraph, OneNote inserts it
in a note with a link to the source.

Research the median salary for a single year for this career. Create a mathematical equation in the Median
Salary section that multiplies the amount of the median salary times 20 years to calculate how much you will
possibly earn.

For the Employment Outlook section, research the outlook for your career path. Take at least four notes about what you
find when researching the topic.

Sync your notes with your OneDrive. Submit your assignment in the format specified by your instructor.
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. Introduction to Sway

- N Sway site | responsive design | Storyline | card | Creative Commons license | animation

Bottom Line emphasis effects | Docs.com

* Drag photos, videos, and
files from your computer and
content from Facebook and
Twitter directly to your Sway
presentation.

¢ Run Sway in a web browser or
as an app on your smartphone,

Expressing your ideas in a presentation typically means creating PowerPoint slides
or a Word document. Microsoft Sway gives you another way to engage an audience.
Sway is a free Microsoft tool available at Sway.com or as an app in Office 365.
Using Sway, you can combine text, images, videos, and social media in a website
called a Sway site that you can share and display on any device. To get started,
you create a digital story on a web-based canvas without borders, slides, cells, or
B R page break.& A Sway site organizes the text, images, and video in?o a responsi\.le
RS design, which means your content adapts perfectly to any screen size as shown in
L J  Figure 6. You store a Sway site in the cloud on OneDrive using a free Microsoft
account.

You can display a
Sway presentation
in a web browser.

Sway uses
responsive
design to make
sure pages fit
perfectly on
any device.

Medical Defibrillator

» Ambulance drone can help heartaftack victims in under 2 minutes with

Medical Defibrillator

© iStock.com/marinello, © iStock.com/marekuliasz

Creating a Sway Presentation

You can use Sway to build a digital flyer, a club newsletter, a vacation blog, an informa-
tional site, a digital art portfolio, or a new product rollout. After you select your topic
and sign into Sway with your Microsoft account, a Storyline opens, providing tools
and a work area for composing your digital story. See Figure 7. Each story can include
text, images, and videos. You create a Sway by adding text and media content into a
Storyline section, or card. To add pictures, videos, or documents, select a card in the
left pane and then select the Insert Content button. The first card in a Sway presenta-
tion contains a title and background image.

Learn to use Sway!

Links to companion Sways,
featuring videos with hands-on
instructions, are located on
www.cengagebrain.com.
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Figure 7: Creating a Sway site

Design and create
Sway presentations. Share and play
published Sway sites.

Adl Cards » Foryfine < TEree
Arrange content in a Storyline,

- which contains all the text,

Title your Sway pictures, videos, and other
media in a Sway presentation.

iats Py
B | v To add content, select a
HE card, which is designed After selecting a card,
to hold a particular type click the Insert Content
of information. button to add the content

to the Sway presentation.

Adding Content to Build a Story

As you work, Sway searches the Internet to help you find relevant images, videos,

) 3 ” On the Job Now
tweets, and other content from online sources such as Bing, YouTube, Twitter, and o
Facebook. You can drag content from the search results right into the Storyline. In  If you have a Microsoft Word
addition, you can upload your own images and videos directly in the presentation. ~ document containing an outline

For example, if you are creating a Sway presentation about the market for commer- ~ ©f Your business content, drag the
outline into Sway to create a card

cial drones, Sway suggests content to incorporate into the presentation by displaying ¢ " L bic.

it in the left pane as search results. The search results include drone images tagged "
with a Creative Commons license at online sources as shown in Figure 8. A Creative

Commons license is a public copyright license that allows the free distribution of an

otherwise copyrighted work. In addition, you can specify the source of the media. For

example, you can add your own Facebook or OneNote pictures and videos in Sway

without leaving the app.

Figure 8: Images in Sway search results
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Desighing a Sway
Sway professionally designs your Storyline content by resizing background images and
On the Job Now  fonts to fit your display, and by floating text, animating media, embedding video, and
"~ removing images as a page scrolls out of view. Sway also evaluates the images in your
Storyline and suggests a color palette based on colors that appear in your photos. Use

If your project team wants to col-
laborate on a Sway presentation,

click the Authors button on the the Design button to display tools including color palettes, font choices, animation
navigation bar to invite others to  emphasis effects, and style templates to provide a personality for a Sway presentation.
edit the presentation. Instead of creating your own design, you can click the Remix button, which randomly

selects unique designs for your Sway site.

Publishing a Sway

Use the Play button to display your finished Sway presentation as a website. The
Address bar includes a unique web address where others can view your Sway site. As
the author, you can edit a published Sway site by clicking the Edit button (pencil icon)
on the Sway toolbar.

Sharing a Sway

When you are ready to share your Sway website, you have several options as shown in
Figure 9. Use the Share slider button to share the Sway site publically or keep it private.
If you add the Sway site to the Microsoft Docs.com public gallery, anyone worldwide can
use Bing, Google, or other search engines to find, view, and share your Sway site. You can
also share your Sway site using Facebook, Twitter, Google+, Yammer, and other social
media sites. Link your presentation to any webpage or email the link to your audience.
Sway can also generate a code for embedding the link within another webpage.

Figure 9: Sharing a Sway site
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1: Creating a Sway Resume
Sway is a digital storytelling app. Create a Sway resume to share the skills, job experi-
ences, and achievements you have that match the requirements of a future job interest.
Perform the following tasks:

a.

b.

C.
d.

&

Learn to use Sway!

Links to companion Sways,
featuring videos with hands-on
instructions, are located on
www.cengagebrain.com.

Create a new presentation in Sway to use as a digital resume. Title the Sway

Storyline with your full name and then select a background image.

Create three separate sections titled Academic Background, Work Experience, and Skills, and insert text, a picture,
and a paragraph or bulleted points in each section. Be sure to include your own picture.

Add a fourth section that includes a video about your school that you find online.

Customize the design of your presentation.

Submit your assignment link in the format specified by your instructor.

2: Creating an Online Sway Newsletter
Newsletters are designed to capture the attention of their target audience. Using Sway, create a newsletter for a club, organiza-
tion, or your favorite music group. Perform the following tasks:

a.

b.

Create a new presentation in Sway to use as a digital newsletter for a club, organization, or your favorite music group.
Provide a title for the Sway Storyline and select an appropriate background image.

Select three separate sections with appropriate titles, such as Upcoming Events. In each section, insert text, a picture,
and a paragraph or bulleted points.

Add a fourth section that includes a video about your selected topic.

d. Customize the design of your presentation.

€

Submit your assignment link in the format specified by your instructor.

3: Creating and Sharing a Technology Presentation
To place a Sway presentation in the hands of your entire audience, you can share a link to the Sway presentation. Create a Sway
presentation on a new technology and share it with your class. Perform the following tasks:

a.

o a0 o

Create a new presentation in Sway about a cutting-edge technology topic. Provide a title for the Sway Storyline and
select a background image.

Create four separate sections about your topic, and include text, a picture, and a paragraph in each section.

Add a fifth section that includes a video about your topic.

Customize the design of your presentation.

Share the link to your Sway with your classmates and submit your assignment link in the format specified by your
instructor.
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Bottom Line

» Office Mix is a free PowerPoint
add-in from Microsoft that adds
features to PowerPoint.

* The Mix tab on the PowerPoint
ribbon provides tools for creat-
ing screen recordings, videos,
interactive quizzes, and live
webpages.

Learn to use Office Mix!
Links to companion Sways,
featuring videos with hands-on
instructions, are located on
www.cengagebrain.com.

» Introduction to Office Mix

add-in | clip | slide recording | Slide Notes | screen recording | free-response quiz

To enliven business meetings and lectures, Microsoft adds a new dimension to pre-
sentations with a powerful toolset called Office Mix, a free add-in for PowerPoint. (An
add-in is software that works with an installed app to extend its features.) Using Office
Mix, you can record yourself on video, capture still and moving images on your desk-
top, and insert interactive elements such as quizzes and live webpages directly into
PowerPoint slides. When you post the finished presentation to OneDrive, Office Mix
provides a link you can share with friends and colleagues. Anyone with an Internet
connection and a web browser can watch a published Office Mix presentation, such as
the one in Figure 10, on a computer or mobile device.

Figure 10: Office Mix presentation

D oot =

€ 5 O |8 wemsmsssnmpie@=YOU Can view a published
Office Mix presentation in a
browser on any device, even
if PowerPoint is not installed.

Microsoft
Click to continue Ofﬁce MIX

to the next slide Professor Carinne Hoisingtan

Display a list of
slides with titles.

Adding Office Mix to PowerPoint

To get started, you create an Office Mix account at the website mix.office.com using an
email address or a Facebook or Google account. Next, you download and install the Office
Mix add-in (see Figure 11). Office Mix appears as a new tab named Mix on the PowerPoint
ribbon in versions of Office 2013 and Office 2016 running on personal computers (PCs).

Figure 11: Getting started with Office Mix
@ Office Mix x [+

~ = O ‘E} mix.office.com () mm—
u Office Mix

Download the Office Mix free
add-in from mix.office.com.

PowerPoint
Click the Get Office Mix Gets Interactive

button to download Office
Mix and install it as a tab Get Office Mix
on the PowerPoint ribbon.
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Capturing Video Clips
A clip is a short segment of audio, such as music, or video. After finishing the content
on a PowerPoint slide, you can use Office Mix to add a video clip to animate or illus- On the Job Now
trate the content. Office Mix creates video clips in two ways: by recording live action ' . ' .

. . Companies are using Office Mix to
on a webcam and by capturing screen images and movements. If your computer hasa  t/5in employees about new prod-
webcam, you can record yourself and annotate the slide to create a slide recording as ucts, to explain benefit packages

shown in Figure 12. to new workers, and to educate
interns about office procedures.

Figure 12: Making a slide recording

Re_cord your b St s Use the Slide Notes

voice; also button to display

record video if notes for your

your computer E——— For best results,

look directly at
your webcam
while recording
video.

has a camera.

ralng

—— 2

Choose a video
2 and audio device
Use inking tools to write to record images
and draw on the slide as and sound.

you record. @

When you are making a slide recording, you can record your spoken narration at
the same time. The Slide Notes feature works like a teleprompter to help you focus
on your presentation content instead of memorizing your narration. Use the Inking On the Job Now
tools to make annotations or add highlighting using different pen types and colors.
After finishing a recording, edit the video in PowerPoint to trim the length or set . . .
lavback onti accessible to people with hearing
playback options. ) ) ) ) ) impairments, use the Office Mix
The second way to create a video is to capture on-screen images and actions with or  ¢|osed-captioning tools. You can
without a voiceover. This method is ideal if you want to show how to use your favorite  also use closed captions to sup-
website or demonstrate an app such as OneNote. To share your screen with an audi- ~ Plement audio that is difficult to
ence, select the part of the screen you want to show in the video. Office Mix captures ~ understand and to provide an aid
. . . - for those learning to read.
everything that happens in that area to create a screen recording, as shown in Figure 13.
Office Mix inserts the screen recording as a video in the slide.

To make your video recordings

Figure 13: Making a screen recording

', Record the action on < -

the screen within the o
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Inserting Quizzes, Live Webpages, and Apps

To enhance and assess audience understanding, make your slides interactive by
adding quizzes, live webpages, and apps. Quizzes give immediate feedback to the
user as shown in Figure 14. Office Mix supports several quiz formats, including a
free-response quiz similar to a short answer quiz, and true/false, multiple-choice,
and multiple-response formats.

Figure 14: Creating an interactive quiz
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Sharing an Office Mix Presentation

When you complete your work with Office Mix, upload the presentation to your per-
sonal Office Mix dashboard as shown in Figure 15. Users of PCs, Macs, iOS devices,
and Android devices can access and play Office Mix presentations. The Office Mix
dashboard displays built-in analytics that include the quiz results and how much time
viewers spent on each slide. You can play completed Office Mix presentations online or
download them as movies.

Figure 15: Sharing an Office Mix presentation

Uptad 1o Mix = Microsaft Office Mi < Conne tiet Office Mix dashboard
i e wenss displays the quiz analytics.
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Learn to use Office Mix!
Links to companion Sways,
featuring videos with hands-on
instructions, are located on
www.cengagebrain.com.

1: Creating an Office Mix Tutorial for OneNote
Note: This activity requires a microphone on your computer.

Office Mix makes it easy to record screens and their contents. Create PowerPoint
slides with an Office Mix screen recording to show OneNote 2016 features. Perform
the following tasks:

a. Create a PowerPoint presentation with the Ion Boardroom template. Create
an opening slide with the title My Favorite OneNote Features and enter your name in the subtitle.

b. Create three additional slides, each titled with a new feature of OneNote. Open OneNote and use the Mix tab in
PowerPoint to capture three separate screen recordings that teach your favorite features.

c. Add a fifth slide that quizzes the user with a multiple-choice question about OneNote and includes four responses.
Be sure to insert a checkmark indicating the correct response.

d. Upload the completed presentation to your Office Mix dashboard and share the link with your instructor.

e. Submit your assignment link in the format specified by your instructor.

2: Teaching Augmented Reality with Office Mix
Note: This activity requires a webcam or built-in video camera on your computer.
A local elementary school has asked you to teach augmented reality to its students using Office Mix. Perform the
following tasks:
a. Research augmented reality using your favorite online search tools.
b. Create a PowerPoint presentation with the Frame template. Create an opening slide with the title Augmented Reality
and enter your name in the subtitle.
c. Create a slide with four bullets summarizing your research of augmented reality. Create a 20-second slide recording of
yourself providing a quick overview of augmented reality.
d. Create another slide with a 30-second screen recording of a video about augmented reality from a site such as YouTube
or another video-sharing site.
e. Add a final slide that quizzes the user with a true/false question about augmented reality. Be sure to insert a checkmark
indicating the correct response.
f. Upload the completed presentation to your Office Mix dashboard and share the link with your instructor.
g. Submit your assignment link in the format specified by your instructor.

3: Marketing a Travel Destination with Office Mix
Note: This activity requires a webcam or built-in video camera on your computer.
To convince your audience to travel to a particular city, create a slide presentation marketing any city in the world using a slide
recording, screen recording, and a quiz. Perform the following tasks:
a. Create a PowerPoint presentation with any template. Create an opening slide with the title of the city you are marketing
as a travel destination and your name in the subtitle.
b. Create a slide with four bullets about the featured city. Create a 30-second slide recording of yourself explaining why
this city is the perfect vacation destination.
c. Create another slide with a 20-second screen recording of a travel video about the city from a site such as YouTube or
another video-sharing site.
d. Add a final slide that quizzes the user with a multiple-choice question about the featured city with five responses. Be
sure to include a checkmark indicating the correct response.
e. Upload the completed presentation to your Office Mix dashboard and share your link with your instructor.
f. Submit your assignment link in the format specified by your instructor.
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 Introduction to Microsoft Edge

( ] ) Reading view | Hub | Cortana | Web Note | Inking | sandbox

Bottom Line

« Microsoft Edge is the name of Microsoft Edge is the default web browser developed for the Windows 10 operating
the new web browser built into system as a replacement for Internet Explorer. Unlike its predecessor, Edge lets you
Windows 10. write on webpages, read webpages without advertisements and other distractions,

« Microsoft Edge allows you to and search for information using a virtual personal assistant. The Edge interface is
search the web faster, take web clean and basic, as shown in Figure 16, meaning you can pay more attention to the
notes, read webpages without webpage content.
distractions, and get instant
assistance from Cortana.

Figure 16: Microsoft Edge tools
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button button the Address bar reading list button
e ] . - o x |
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Hub (Favorites, reading list,
Refresh (F5) history, and downloads) Make a Web
button button Note button

Browsing the Web with Microsoft Edge
One of the fastest browsers available, Edge allows you to type search text directly in the
Address bar. As you view the resulting webpage, you can switch to Reading view, which
is available for most news and research sites, to eliminate distracting advertisements.
For example, if you are catching up on technology news online, the webpage might
be difficult to read due to a busy layout cluttered with ads. Switch to Reading view to
refresh the page and remove the original page formatting, ads, and menu sidebars to
read the article distraction-free.

Consider the Hub in Microsoft Edge as providing one-stop access to all the things
you collect on the web, such as your favorite websites, reading list, surfing history, and
downloaded files.

Learn to use Edge!

Links to companion Sways,
featuring videos with hands-on
instructions, are located on
www.cengagebrain.com.

On the Job Now

Businesses started adopting Locating Information with Cortana

Internet Explorer more than Cortana, the Windows 10 virtual assistant, plays an important role in Microsoft Edge.
20 years ago simply to view After you turn on Cortana, it appears as an animated circle in the Address bar when
webpages. Today, Microsoft you might need assistance, as shown in the restaurant website in Figure 17. When you

Edge has a different purpose: click the Cortana icon, a pane slides in from the right of the browser window to display
to promote interaction with the

web and share its contents with detailed information about the restaurant, including maps and reviews. Cortana can
colleagues. also assist you in defining words, finding the weather, suggesting coupons for shop-
e  ping, updating stock market information, and calculating math.
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Figure 17: Cortana providing restaurant information
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Annotating Webpages

One of the most impressive Microsoft Edge features are the Web Note tools, which
you use to write on a webpage or to highlight text. When you click the Make a Web
Note button, an Inking toolbar appears, as shown in Figure 18, that provides writing
and drawing tools. These tools include an eraser, a pen, and a highlighter with differ-
ent colors. You can also insert a typed note and copy a screen image (called a screen
clipping). You can draw with a pointing device, fingertip, or stylus using different pen
colors. Whether you add notes to a recipe, annotate sources for a research paper, or
select a product while shopping online, the Web Note tools can enhance your produc-
tivity. After you complete your notes, click the Save button to save the annotations to
OneNote, your Favorites list, or your Reading list. You can share the inked page with
others using the Share Web Note button.

Figure 18: Web Note tools in Microsoft Edge
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Learn to use Edge!

Links to companion Sways,
featuring videos with hands-on
instructions, are located on
www.cengagebrain.com.

1: Using Cortana in Microsoft Edge

Note: This activity requires using Microsoft Edge on a Windows 10 computer.
Cortana can assist you in finding information on a webpage in Microsoft Edge. Per-
form the following tasks:
a. Create a Word document using the Word Screen Clipping tool to capture the
following screenshots.

o Screenshot A—Using Microsoft Edge, open a webpage with a technology news article. Right-click a term in the
article and ask Cortana to define it.

o Screenshot B—Using Microsoft Edge, open the website of a fancy restaurant in a city near you. Make sure the
Cortana circle icon is displayed in the Address bar. (If it's not displayed, find a different restaurant website.) Click the
Cortana circle icon to display a pane with information about the restaurant.

o Screenshot C—Using Microsoft Edge, type 10 USD to Euros in the Address bar without pressing the Enter key.
Cortana converts the U.S. dollars to Euros.

o Screenshot D—Using Microsoft Edge, type Apple stock in the Address bar without pressing the Enter key. Cortana
displays the current stock quote.

b. Submit your assignment in the format specified by your instructor.

2: Viewing Online News with Reading View
Note: This activity requires using Microsoft Edge on a Windows 10 computer.
Reading view in Microsoft Edge can make a webpage less cluttered with ads and other distractions. Perform the following
tasks:
a. Create a Word document using the Word Screen Clipping tool to capture the following screenshots.

o Screenshot A—Using Microsoft Edge, open the website mashable.com. Open a technology article. Click the Reading
view button to display an ad-free page that uses only basic text formatting.

o Screenshot B—Using Microsoft Edge, open the website bbc.com. Open any news article. Click the Reading view
button to display an ad-free page that uses only basic text formatting.

o Screenshot C—Make three types of annotations (Pen, Highlighter, and Add a typed note) on the BBC article page
displayed in Reading view.

b. Submit your assignment in the format specified by your instructor.

3: Inking with Microsoft Edge
Note: This activity requires using Microsoft Edge on a Windows 10 computer.
Microsoft Edge provides many annotation options to record your ideas. Perform the following tasks:

a. Open the website wolframalpha.com in the Microsoft Edge browser. Wolfram Alpha is a well-respected academic
search engine. Type US$100 1965 dollars in 2015 in the Wolfram Alpha search text box and press the Enter key.

b. Click the Make a Web Note button to display the Web Note tools. Using the Pen tool, draw a circle around the
result on the webpage. Save the page to OneNote.

c. In the Wolfram Alpha search text box, type the name of the city closest to where you live and press the Enter key.
Using the Highlighter tool, highlight at least three interesting results. Add a note and then type a sentence about
what you learned about this city. Save the page to OneNote. Share your OneNote notebook with your instructor.

d. Submit your assignment link in the format specified by your instructor.
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Word 2016 Module 5

Creating and
Formatting Tables

m You are preparing a summary budget for an advertising campaign aimed at the
Boston market. The goal of the ad campaign is to promote winter projects in

tropical destinations. You decide to format the budget information as a table so that it is easy to
read and analyze.

After completing this module, you will be able to:

* |nsertatable o Splitand merge cells
e |nsert and delete rows and columns e Perform calculations in tables
* Modify rows and columns e Apply atable style

Sort table data Customize a table format

Files You Will Need

WD 5-1.docx WD 5-2.docx

o8
%
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=
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el Insert a Table

Learning A table is a grid made up of rows and columns of cells that you can fill with text and graphics. A cell is
OIUtc?mte;I the box formed by the intersection of a column and a row. The lines that divide the columns and rows
,T';S:; tzxtainea wble  and help you see the grid-like structure of a table are called borders. You can create a table in a document
* Add rows by using the Table command in the Tables group on the Insert tab. Once you have created a table, you

m can add text and graphics to it. (X3 You begin by inserting a blank table and adding text to it.

QUICK TIP 1. Start Word, click Blank document, click the View tab, then click the Page Width button

If the rulers are not :
in the Zoom grou
displayed, click the 9 P

Ruler check box in 2. Click the Insert tab, then click the Table button in the Tables group
EE: \S/?e‘:A‘/"’tg{)"”p on The Table menu opens. It includes a grid for selecting the number of columns and rows you want the table
: to contain, as well as several commands for inserting a table. TABLE 5-1 describes these commands. As you
move the pointer across the grid, a preview of the table with the specified number of columns and rows
appears in the document at the location of the insertion point.
3. Point to the second box in the fourth row to select 2x4 Table, then click
A table with two columns and four rows is inserted in the document, as shown in FIGURE 5-1. Black borders
surround the table cells. The insertion point is in the first cell in the first row.
4. Type Location, then press [Tab]
Pressing [Tab] moves the insertion point to the next cell in the row.
5. Type Cost, press [Tab], then type The Boston Globe
Pressing [Tab] at the end of a row moves the insertion point to the first cell in the next row.
6. Press [Tab], type 28,900, press [Tab], then type the following text in the table, pressing
[Tab] to move from cell to cell

Boston.com 26,000
Taxi tops 16,000
7. Press [Tab]

Pressing [Tab] at the end of the last cell of a table creates a new row at the bottom of the table, as shown in
FIGURE 5-2. The insertion point is located in the first cell in the new row.

TROUBLE 8. Type the following, pressing [Tab] to move from cell to cell and to create new rows
If you pressed [Tab]
after the last row, Cambridge Chronicle 17,460
click the Undo button ;
on the Quick Wickedlocal.com 5,750
Access toolbar to MBTA stops 12,000
remove the new Boston Magazine 11,400
blank row.

9. Click the Save button [£] on the Quick Access toolbar, then save the document as
WD 5-Boston Ad Budget to the location where you store your Data Files

The table is shown in FIGURE 5-3.
TABLE 5-1: Table menu commands

command use to

Insert Table Create a table with any number of columns and rows and select an AutoFit behavior

Draw Table Create a complex table by drawing the table columns and rows

Convert Text to Table Convert text that is separated by tabs, commas, or another separator character into a table
Excel Spreadsheet Insert a blank Excel worksheet into the document as an embedded object

Quick Tables Insert a preformatted table template and replace the placeholder data with your own data

Creating and Formatting Tables
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FIGURE 5-1: Blank tahle
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/| Banded Rows [ | Banded Columns | | 5;;;:ZPeHCnlur' ?mp;rnt:
Table Style Options Borders m
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[nsertion point —|
Row —> [<€— Cell
FIGURE 5-2: New row in table
L L---l---lg ....... i3 . .. s 4 f 5 & 7
=
Location Cost
The Boston Globe 28,900
Boston.com 26,000
X Taxi tops 16,000
- New row —> |
FIGURE 5-3: Text in the table
L 1---|---ﬂ-‘--‘-1-‘-“‘2“‘“‘Jﬁg‘u‘-‘4‘-‘|‘--5---|--- P R
]
Location Cost
The Boston Globe 28,900
Boston.com 26,000
Taxi tops 16,000
Cambridge Chronicle 17,460
Wickedlocal.com 5,750
MBTA stops 12,000
Boston Magazine 11,400

Converting text to a table and a table to text

Starting with a blank table is just one way to create a table. You
can also convert text that is separated by a tab, a comma, or
another separator character into a table. For example, to create
a two-column table of last and first names, you could type the
names as a list with a comma separating the last and first name
in each line, and then convert the text to a table. The separator
character—a comma in this example—indicates where you want
to divide the table into columns, and a paragraph mark
indicates where you want to begin a new row. To convert text

to a table, select the text, click the Table button in the Tables
group on the Insert tab, and then click Convert Text to Table. In
the Convert Text to Table dialog box, select from the options for

structuring and formatting the table, and then click OK to

create the table.

Conversely, you can convert a table to text that is separated
by tabs, commas, or some other character by selecting the table,
clicking the Table Tools Layout tab, and then clicking the Convert

to Text button in the Data group.

Creating and Formatting Tables m
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